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 Data Entry Script   

Clip Link:  

http://www.priority-software.com/eshbel.com/Movie_Search/Data_Entry_Clip.htm 

Note: Yellow highlights indicate action instructions.   

Introduction (00:00-00:09)  

  

Hi, this is_______  from Priority Software.  

In this video I will demonstrate how to add data to Priority forms and edit existing data.   

Form Structure in Priority (0:10-1:07)  

For demonstration purposes, let's open the Sales Orders form from the Sales menu and 

then the Orders menu. The form opens in Data Entry mode, as indicated by the white color 

of the Customer No.  column in which the cursor is currently placed. In this mode, you can 

record data in the form, and they are saved automatically in the system database, with no 

need to hit a "Save" button. The other available mode is Query Mode, accessed by pressing 

F11, and identifiable by the green color. Since I haven't written anything yet, I can return to 

Data Entry mode by pressing Enter.   

Note the red star next to various columns. This indicates a mandatory column. If you record 

an order and leave one of these columns empty, an error message appears. The gray 

columns are read-only, meaning they cannot be updated in this form.   

 Data Entry in Forms (1:08-1:56)  

Let's begin filling in the form by selecting the customer for which the order is placed. Open a 

Choose list by clicking on the arrow to the right of the column name or by pressing F6. The 

list displays customers defined in the Customers form. You can scroll through it by 

pressing Next Page or by pressing the Page Down button on your keyboard. If the list is 

long, you can type part of the customer's name, and the list will display the options that 

match.   

Once you choose a customer, a number of other columns are filled in automatically: the 

customer's name, the Date of the order, and the Order No., which is assigned in keeping 

with a defined order numeration template. The default Currency defined for the customer 

appears as well.   

Text Columns (1:57-2:33)  

Some forms contain columns in which you can freely record text, as opposed to Choose 

columns in which you select predefined values, like the customer or sales rep. In the 

Details column, let's record a note concerning the order. Note that when you return to the 

column to revise the details, the entire text is highlighted. If you start writing immediately, 

the previous text will be overwritten. To switch to editing mode, press F2 and use the 

mouse or arrow buttons to move the cursor to the desired place. Press Home to place the 

cursor on the first character of the text, and edit.   

http://www.priority-software.com/eshbel.com/Movie_Search/Data_Entry_Clip.htm
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Numerical Columns (2:34-3:04)  

Let's go back to the Date column, which currently displays today's date. To change the 

date, you can manually record a new one or choose a number of other options. For 

instance, you can use the plus "+" button to move the date forward by one day, or the 

minus "-" button to move it backwards. To postpone the order date by a few days, press the 

plus "+" button several times. The plus and minus buttons can be used in all numerical 

columns, not just for dates. In date columns, you can also click the calendar icon and 

choose the date from the calendar.   

Recording Data in Another Form and Saving to the Current Form (3:05-3:58)  

Now, move to the Payment Info tab. When you open a Choose list, the data that appears is 

taken from a different form in Priority – Customers, Sales Representatives, or, in this 

case, Payment Terms. Suppose that the payment terms on which you agreed with the 

customer don't appear here, and you want to define new terms while recording the order. 

Press F6 from the open Choose list to move to the Payment Terms form, and Ctrl+Enter 

to open a new record there. Now fill in the details: record the Payment Terms Code and a 

description, flag the End of Month column, and record the number of Months. To return to 

the Sales Order form while saving the current selection, that is, filling in the current value in 

that form, press F8. The new payment terms have been recorded in the order, and are also 

updated in the system, and will appear in all the Choose lists for this column.   

Filling Sub-Level Forms (3:59-4:39)  

Now I'll demonstrate how to fill in data in sub-level forms, by moving to the Order Items 

sub-level form. Open the Choose list in the Part Number column, a mandatory column in 

this form, and select the desired item. Record the ordered Quantity of the current item. You 

can move between columns using the Tab button, the left and right arrows, and of course 

by clicking with your mouse.  

You can see that the Unit Price column has been filled in with a price. To understand the 

displayed price, press F1 while the cursor is placed in the column, and read the detailed 

help text for this column. In the case of the Unit Price, you can also see the Price Source 

that appears in the adjacent column.   

Data Generator (4:40-6:18)  

The Due Date column is also mandatory, as indicated by its red star. You can record it 

manually, but you can also set up definitions that will fill in the column automatically once 

certain conditions are met. To do so, open the Data Generator from the Design menu. I'll 

use it to determine that, when a value is defined in the Part Number column, the Due Date 

will automatically receive a date that is seven days later than the current date.   

Open the Choose list adjacent to "After updating" and select Part Number. From the next 

Choose list, after "set", select Due Date. In the third field, you can click on the calendar icon 

to see if any of the options available here match the rule you wish to set up. If the options 

shown here aren't suitable for the current rule, you can click on the function key to manually 

define the terms. In this demonstration, I'll add a predefined expression, and select "current 

date (w/o time)" to add just the date. Now I'll add seven days: since the basic unit in the 
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expression is hours, write plus seven, multiplied by 24 to add seven whole days. In the 

"Valid for" area, you can determine that the rule will be in effect only for yourself, i.e., the 

user currently defining the rule, or for others too. Only users for whom the Write Business 

Rules for All column is flagged in the User Permissions form can set up rules that are 

valid for other users. I'll leave the system default definitions as is, meaning the rule will be in 

effect only for the current user. I click OK to exit the generator and activate the rule.   

Business Rules Generator (6:19-7:39)  

Let's move to the Overall Discount% column. In orders and many other types of 

documents, you can define a discount for a specific item in the sub-level form, or for the 

entire order in the upper-level form. In the following example, I'll demonstrate how to set up 

a rule that limits the percentage of discount you can define for any order item, so as to 

prevent exceptionally high discounts in orders. Open the Design menu again, and this time 

select the Business Rules Generator. This generator is used to define automatic actions, 

such as the appearance of an error message or sending an e-mail, if the record meets 

defined conditions.   

Let's choose to display an error message that will appear if users assign items a discount 

greater than 30%. Move to the "Message" pane and record the message to be displayed. 

Note that you can add a field to the message,thereby inserting the value of the chosen field 

into the message. Now, define the conditions: If the value of the overall discount, is greater 

than, 30.  

This time, make the rule valid for all users. Note that instead of an error message, you can 

display a warning message, which will not prevent the action but only warn users, or send 

an e-mail message to another user, such as the branch manager, notifying her of the high 

discount rate.   

Undoing Typing (7:40-7:59)  

Back in the Order Items form, let's see if the rule works: record a discount of 50% and try to 

go down one line to update the record. The error message appears, so press Ctrl+Z to 

undo the typing. You can use Ctrl+Z to erase the last thing you recorded as long as you 

haven't left the line.   

Copying Field Values (8:00-9:57)  

Once you move to the next line, the previous line is recorded in the system database. You 

can go down a line using Page Down, Ctrl+Enter or simply by pressing the down arrow. 

Fill in the Part Number and move to the Quantity column. Note that the Due Date has 

been filled in automatically, meaning that the rule defined in the Data Generator is working. 

To copy quantities from the previous line, press F10. This shortcut always copies the value 

from the same column in the previous record.  

Let's record another line, with the same Part Number this time. If you want to copy a value 

from the previous line, you can also use keyboard shortcuts, such as Ctrl+C, then paste in 

the new line by using Ctrl+V. Alternatively, right-click the column and select Paste. Note 

that many other options, such as copying the field above, are available from this list, and its 

keyboard shortcut, F10, is also displayed.   
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A third option for copying values is to store values in buffers. Buffers allow you to store 

multiple values, as opposed to simply copying a single value by pressing Ctrl+C. Suppose 

you want to copy the Part Number from the first and second items, and paste them in the 

fourth and fifth lines. Place the cursor on the Part Number column in the first line and press 

Ctrl+F9. The value is stored in a "cell" identified by the number recorded here - in this case, 

1. You can designate any one- or two-digit number you want. Repeat the action in the 

second line, this time assigning the buffer a cell number of 2, which appears automatically, 

since the system "recognizes" that number 1 is already taken. In the fourth line, press F9. 

"1" appears by default, so simply press Enter to paste the first stored value. In the fifth line, 

press F9 again and this time make sure the number "2" is recorded, then press Enter.   

Deleting Records (9:58-10:41)  

A couple of redundant lines have been added to the Order Items form. If you haven't left 

the record yet, meaning you are still in the same line, you can press F7 to clear this line 

from the form. F7 usually removes records from the current display, but in this case, since 

this is a new record and has not yet been stored in the database, the line is removed and 

will not be registered in the system.   

The previous line, on the other hand, has been recorded in the database, which happens 

when you leave the line. To erase it, click the icon or press Ctrl+Delete. In some cases, 

you may not be able to delete a record at all. For example, you can't delete line items in an 

approved sales order.   

Storing and Retrieving Multiple Records (10:42-11:35)  

You can copy items into the new sales order from an existing record, and in fact copy the 

entire content of any sub-level form into the same sub-level of a different record. Move to 

the relevant record, then to its sub-level. From the Edit menu, choose the Store Records 

option to copy all the items in the form. In the dialogue box, choose the cell in which to store 

the records. Now return to the upper-level Sales Orders form and open a new sales order 

by pressing Page Down. Then, choose a customer. Select Retrieve Records from the Edit 

menu, making sure the same cell number appears. The items are copied into the sub-level 

form. Note that you store the records in the buffer while in the sub-level form of the source 

record, but you retrieve them into the target record while in the upper-level form.  

Summing Values (11:35-12:15)  

Let's look at the Order Total sub-level form, in which the total prices for the order are 

displayed, before and after discounts and taxes. This is useful for viewing an interim 

summary of the order while itemizing it, but perhaps you want to add data that is not 

displayed in the Order Total, such as the Profit column in the Order Items form, which 

takes into account part costs and prices. If you right-click the column title, you can see a 

sum total of all the values in the column. To obtain a subtotal of the values from the 

beginning of the column up to a certain line, place the cursor on that line and press Ctrl+F8.  

Sending a Record Link (12:15-12:34)  

Let's go back to the upper-level form to demonstrate additional actions. You can send a link 

to this record to other users by pressing Ctrl+S. This opens an e-mail message containing 
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a link which leads directly to this record in Priority. This option is also available from the 

Mail menu.   

Text Forms (12:34-14:30)  

Another kind of data entry in Priority is recording remarks in text forms, such as the Sales 

Orders – Remarks form. The form may display a set text for sales orders, if one was 

defined. You can edit the text for an individual order.  

All the standard functions of text editors are available in text forms in Priority: cutting, 

copying, pasting and deleting. You can perform these actions from the toolbar or use 

standard keyboard shortcuts, like Ctrl+X. You can also format the text, and add hyperlinks 

and images.   

In addition, you can add a personal signature, appended to the text messages you edit.  

From the upper File menu, select User Signature, and select the second option – in Text 

Forms. In the next screen, determine the text and design of the signature: whether to 

include a separating line, a date and so on. Some of the signature definitions, like title and 

position, are filled in based on data from the user's Personnel File. The signature will 

appear when you click the Add a Comment button.   

The content of the Sales Orders – Remarks form will appear in printouts of the order. In 

addition to recording text that is visible to the customer, you can use a separate form to 

record internal remarks intended only for company employees. To do so, move to the 

Internal Dialogue form. Click the Add a Comment button to add your signature, then 

record the text. The content of the text forms is saved automatically every couple of 

minutes, and when you leave the text form.   

You can also add a link to other Priority records that works like a regular hyperlink. For 

demonstration purposes, let's paste a link here to a prospective vendor for this order. 

Record the relevant text and move to the vendor record. Press Ctrl+Y to copy the link, then 

return to the text form and paste using Ctrl+V.   

Attachment Forms (14:30-14:47)  

You can attach files of any type to a variety of records. In the Attachments sub-level form, 

press the folder icon, and import the file. The folder icon changes to match the file type, 

and, if the file is an image, a thumbnail of that image is displayed.   

Macros (14:47-15:48)  

Macros are another powerful editing tool available in Priority forms. Macros are used to 

automatically perform a sequence of several actions such as mouse clicking and 

keystrokes, in order to carry out a particular operation. Note that there is no way to undo 

actions that are performed using a macro, so use caution when doing so.  

Let's use this sample order to demonstrate how to create a macro that deletes records.  

Begin by choosing the Start Definition command from the Run > Macros menu, and 

recording the name of the macro: "Deletion". On the bottom left corner of the screen a row 

of icons appear. The rightmost icon ( ) indicates that the macro is now being recorded, so 

perform the actions to be included in the macro in their normal sequence: press  
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Ctrl+Delete, then the left arrow key, then Enter. And finally, click the End  icon to stop 

recording. You can now perform the same actions by executing this macro.  

Defining a Macro Hot Key (15:48-16:19)  

To make macro usage even easier, you can assign hot keys to activate each one. This 

eliminates the need to open the Run menu in order to execute a macro. To assign a hot 

key, activate the Select a Macro command, move to the desired macro and specify a 

number between 0 and 9. And finally click Set Key. So now you can simply press Alt+1 at 

any time to execute this macro.   

Defining a Recursive Macro (16:19-17:33)  

In order to delete a large number of records, it is possible to define a recursive macro, 

which repeats the recorded actions a number of times, depending on the value of the 

RECURSIVEMACRO constant. For example, if the value of the constant is 20, the action 

will repeat 20 times, and in this case, delete 20 rows. The process for defining this type of 

macro is very similar to the one for a regular macro, except that in a recursive macro, the 

Select a Macro command itself is included within the definition.  

To define a recursive macro, select the Start Definition command again and assign the 

macro a name in the pop-up dialogue box. I'll use the name “Deletion” again and overwrite 

the existing macro.  

Once again, perform the same sequence of actions: press Ctrl+Delete, then the left arrow 

key, and then Enter. Next, click the Select a Macro   icon, choose the macro you just 

defined, and select Execute. And finally, click the End   icon to stop recording. You 

have created a loop in which one of the actions performed by the macro, is running the 

macro itself, which is then repeated a number of times. To stop the macro while it is 

running, press Ctrl+Break.  

Recording a New Order (17:33-17:50)  

After you have finished entering all the data for the sales order record, you can open a new 

record by pressing Page Down or Ctrl+Enter, and filling it in as demonstrated. To exit the 

form, press Esc.   

This concludes our explanation of basic data entry tools in Priority.  

Related Documentation  

 Navigation clip  

 Form Design clip  

 Data Retrieval and Queries clip   

 User Interface Guide  

 Sales Orders clip  

  


